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Logivision has attempted to make this document accurate. Logivision is not responsible for any direct, incidental, or 
consequential damages resulting from this documentation or inaccuracies within. Specifications are subject to 
change.  

Printed in Canada. 
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Label Printing     

About the application  

Logivision is a corporation specialized in the development of software for the retail industry with a particular focus 
on operation systems for front-end terminals. Innovative and always at the forefront of new technological 
developments, Logivision is committed to improving the service and products we provide to our customers.   

Label printing overview  

The Label printing software provides allows you to print labels and shelf signs. You can use shelf tags to eliminate 
tagging individual products. Sales and other events can be more effectively promoted by using L-BOSS to prepare 
your signs and shelf talkers for products on sale. System features include:  

 

Multiple label formats 

 

Bar code fonts included 

 

Interface to windows desktop printer 

 

Interface to several popular dedicated label printers 

 

Print labels from price change file 

 

Print labels for a batch 

 

Print labels for sale items 

 

Print customer cards 

 

Print labels for individual items  

Note: A working knowledge of the L-BOSS system is a pre-requisite to using the L-BOSS Label system. This 
document covers the L-BOSS label module but does not explain how to format labels or modify the label types 
included in the basic application.  
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Navigating the L-BOSS Application  

Using the mouse  

Throughout the L-BOSS application you will find drop down menus and main screen icon groups to navigate 
through the program or launch utilities. The most commonly used drop down menu options have been included as 
buttons on the L-BOSS desktop to facilitate access. In other words, some drop down menu options lead to the 
same location as clicking that option's icon counterpart.   

Not all options have buttons, and must be launched from the drop down menu. Options that are not often required, 
or single use setup tools (used to configure the system at installation time) do not have main screen buttons. If an 
option does not appear to have a button, use the drop down menus to locate and launch that option.  

Using the keyboard  

As with most Windows style applications, the drop down menu titles and options are also accessible using the 
keyboard. This can actually be faster than navigating with the mouse, after you've memorized the keystrokes 
involved for a specific task. The keystrokes associated with menu titles and options are underlined. For example, 
the "File" menu has an underscore under the "F": 
Hold down the [Alt] key on the keyboard. 
Simultaneously, press the [F] key. 
The File menu opens.   

The options in the drop down menus also have underscored letters. Once a drop down menu is open, you can 
press the letter that is associated with the option you wish to launch. You can also use the [up] or [down] arrow 
keys to select the menu option, and then press [Enter] to launch the option.  

Within applications or utilities, the [Tab] key will move the cursor from one box, window or editable field to the next, 
in a pre-set order. Holding down the [Shift] key and pressing the [Tab] key will reverse the pre-set order. Once the 
cursor is on an option, press the [Enter] key to launch the option.  

Understanding Communications  

While the network is "down" and L-BOSS cannot communicate with the front end no customer account balances 
will be available until the system returns to normal, but the L-POS front end station will prompt the cashier with a 
"server not available - continue anyway?" error message. At this point it is up to the store manager to allow or not 
allow account charges during a network down.  

Backups Are Important!  

Is your sales information important? Is your database important? Is your hardware setup important? The answer is 
always YES! What happens if the system crashes? How can I protect my information? Like any "mission critical" 
information, your L-BOSS installation should be archived on a regular basis. Normally, your Logivision dealer will 
suggest ways to protect your information, based on the type of installation you have, and how much space your 
data actually takes up. In most situations, you'll want to backup every night, (or other time when the system is not 
busy). 
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Setting up L-BOSS label printing  

The Label printing option must be enabled on the license key before you can use the accounts receivable option. If 
your license does not include the Label option, contact your reseller.  

In order to print a label you need to complete several steps.  

 

Create label templates and sql files to select data to print 

 

Program the label types to print for the item file 

 

Printing labels for items 

 

Printing labels from batches 

 

Printing labels from receiving 

 

Printing customer cards  

     

From the L-BOSS main menu 
open the Maintenance program.
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Opening the PLU file   

   

Access PLU programming by clicking the Item icon. 
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Editing tools  

Regardless of which data table you edit, the Maintenance application provides a common set of tools on a toolbar 
at the top of the data table editor. The Maintenance main menus change as well, depending on the table you are 
programming. The toolbar is common to all tables you edit.  

   

Apply changes tool allows you to post the changes to the record within the table being accessed. 

 

Add new record tool is used to add a new blank record to the table you are working with. To copy an existing 
item to a new item, or to replace an existing item with a new number, enter the number directly into the item 
number field. You will then be prompted for the action you want to take. 

 

Delete tool is used to delete an existing record from the table you are working with. 

 

Ignore changes tool is used to undo changes that appear on the screen but that have not yet been posted. It 
will not undo changes that have been posted. 

 

Previous record tool is used to go back to the previous record in the table you are working with. 

 

Next record tool is used to go forward to the next record in the table you are working with. 

 

Send one record tool is used to send the modification made to the current record to the POS terminals 
immediately. This icon changes color to green when a modification has been made to a record. When the record is 
deployed the icon will return to the normal color displayed here.  Clicking the satellite will send the current record to 
the POS terminals whether a change was made or not. 

 

Save and close tool will save the current changes and close the table you are editing.  

NOTE: L-BOSS saves new data in a field once you press tab, enter or when you click in another field. Data is also 
saved when you access another record in the table, or when you open a new table. This means that you do not 

need to press the post tool 

 

after each record you modify, L-BOSS does it automatically for you. 
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Displaying search lists  

L-BOSS uses tables to store data. In some cases the information stored in a table has been indexed so that a rapid 
search can be performed to locate data you require. As you are navigating through the fields of different tables you 
will notice that sometimes a "?" (Question mark) appears beside the cursor. This means that the selected field is 
indexed so that its contents are viewable as a searchable list. Double clicking the selected field will open a viewable 
list of the table's contents.   

The sequential order that the contents will appear depends on which field you have selected for the drop down list. 
For example, if you are editing accounts and double click in the account number field, the list is in numerical order 
according to the account numbers. Double clicking the account name field opens the same information, but listed 
alphabetically according to the account names. The data list's left column will contain the data from the field 
selected.   

Here is a sample of the account search window:  

  

When this type of list is open, you can have many search options. Clicking at the top of any column will use that 
column to sort the data. From the example shown above, if you click on the column header “Company” the list will 
sort in alphabetical order by company name. If you click again in the same column the list will sort again in 
alphabetical order starting from the opposite end of the alphabet. Click in the Acc # column header and the same 
list will sort numerically. Re-click the Acc # number and the list will sort from the last account to the first, etc. You 
can also use the locate entry window to type data. If you have sorted the column by clicking in the Acc # number 
field, the locate tool will search the Account number field. If you have sorted the column by clicking in the company 
field, the locate tool will search the item description field (F29 in the database.) You can sort all the other fields the 
same way by clicking that column header.  
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You can also use this type of search window to perform a wildcard search (the field you are searching contains the 
data in a continuous string.) For example you want to search for all accounts that include the word BEST anywhere 
in the company name. Type the word Best into the locate window. The system will display the first account it 
locates beginning with the word Best. Press the Enh. Search button. The system will display every account that 
includes the word best. So the first list may show no results unless there are accounts that start with Best. But the 
second list would show Best Company, All the Best, etc.  

The File menu option in the search window allows you to send the data from the search list to an export file or to a 
printer. This is a simple way to print a very specific list: set a filter to find your items. The Apply button will produce 
this type of search list that can then be printed (or exported to a csv file.)  

The next major advantage to this type of list is that a customized query can be defined if you understand the LBoss 
database structure and you have a minimum knowledge of sql commands. Access the options menu and select 
custom query. The system will open up an sql editor window. Add the commands you need to select the data you 
want to list. If you are unsure how to do this it is recommended that you inquire with your dealer on how to add 
custom queries.   

Windows menu  

Like many Windows based programs, the Maintenance application allows you to have more than one window 
(table) open at the same time. The Window menu contains options that allow you to control how the windows or 
tables appear on the desktop.    

Cascade: This aligns the open windows in layers, with the corners and title bars of all open windows visible, 
enabling you to find the window you a looking for.  

Tile: This option tries to place all the open windows into the Maintenance application's desktop by re-sizing them.  

Close All: Closes all open windows at once.  

Selecting open windows from a list: If you have multiple windows open on the desktop, you can open the "Window" 
menu and select the window to "bring to front" from the list at the bottom of the menu.  
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Label samples included in L-BOSS  

The label module can print many different label formats. The distribution version includes labels types A, B, C, D 
and E. There is also a sample customer card delivered with the system. All of these are intended as samples only 
and are normally modified for the customer by the dealer or by Logivision.   

Here is a sample of each of the label formats:  

           

Label type A shows UPC, 
Description and price 

Label type B displays UPC, SKU, 
package info and vendor id.

 

Label type C displays UPC, SKU, 
package info and comparative price 
info
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This label displays how you can create shelf talkers and small signs to make your specials stand out for customers 
to notice. This label could have any field from your database included such as sale dates, regular price, a remark 
such as country of origin, etc. By printing a company logo with the printer we can reduce delay to get printed labels 
on the shelves when printer stock runs low.  

  

Label type E is not shown here. It was made for a dedicated label printer with a roll of continuous labels. Many 
other label formats can be created. These samples are provided to assist you in understanding what you can print 
with the label software. 
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Defining label types associated with a PLU  

Each product on file must be associated with a label type before you can print that label type for those products. So 
if you need to print label type A on all products in sub-department 1 it is necessary to modify those items.   

   

Access PLU programming by clicking the Item icon. 

 

When you open Item 
maintenance the system defaults 
to the Quick tab. Click on the 
POS tab to gain access to the 
label type field. 
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There are 2 fields on the POS tab that are related to printing labels. 

 
The Print selection field can be selected manually by placing a check mark (mouse-click or spacebar). But the 
Print field is normally toggled on or off by actions you take on the system. For example, if you change the price 
of the product the Print selection will be made automatically by L-BOSS when you apply the change.  

   

   

The Type field is used to select the type of label that will be available when it is time to print a label for this 
product. You may select up to 6 label types for each product.  

 

Enter the label types that can be 
used to print tags, signs or shelf 
talkers for your product. 

 

Double-click to view the available 
label types.
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Printing labels  

Labels can be printed for individual PLU items, for all items, for modified items, for batches and for received items.  
Once you have specified the label type for each product you are ready to print.  

Labels for a single item  

When you want to print labels for an individual product access the labels folder in L-BOSS>Reports. Under normal 
circumstances you will know the label type attached to your products.   

   

Select the label type you want to print. When you have defined the 
label type a new window will appear so you can select the PLU. 
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To print labels for a single PLU enter the item number. 
Leave the field blank to print labels for ALL items. If you 
do select ALL items you can filter further by choosing 
“Modified PLU’s only” in the Pre-Selection field.  

Select the appropriate POS and Price targets for your 
location (when part of a multi-store operation using 
different prices or tax structures.) 

Depending on the selection you made in the 
previous window, you will either see one 
product or many products in the Selection 
window.  

At this point you can decide how many of 
each label you require. Scroll down the list 
and enter the quantity of labels for each item 
on the list. The Set all to button can be used 
to set all items to a specific quantity.  

Press the OK button to print. 
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If the label you selected prints multiple labels per sheet another prompt will appear to define the starting position for 
the first label that will print. This way if you have used part of a label sheet for a previous item you can start printing 
from the first available position on your label sheet.  

  

The last step is to select the printer (when the printer dialogue window is part of the prompt set-up. If it is select the 
correct printer and make sure your label stock is loaded and ready to print.  

Select the starting position for the first label to print. 
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Printing labels for a price or a promotion batch  

     
If you use batches to prepare price changes and promotional events 
in advance you may want to print labels for the items in the batch.   

The default labels delivered with L-BOSS include a label type that will 
print for items in a batch. This label type does not need to be 
assigned in item maintenance. It will print a label for each item in the 
batch. The batch label sample is displayed below. 

This report prints 1 label for each item in the batch 
you selected. This logic can be modified to display 
the selection grid to allow you to print a specific 
quantity of each label. 
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Printing labels from receiving  

When you have completed a receiving transaction you will be prompted to Print the receiving report, the shelf labels 
or the product labels.  

  

If you choose to print item labels or shelf labels the system will prompt you to print the label styles that exist for 
different products. So if you have defined labels type C for some of the items and label type D for others you will be 
able to select both. 

    

In this example there were items received that use label type 
C and others that use label type D. 

You can also print the labels for a previous receiving transaction. From the Entry 
program select the View menu and open Receiving. Locate the receiving transaction 
you need to print labels for. When the transaction has been opened on the screen, 
access the File command menu and choose from Print, print labels and print shelf 
labels. 
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Printing account cards  

L-BOSS can be configured to print cards to scan for customer number entry. This guide explains how to use the 
system to print the cards. Your system must include the label module and you need top have card stock compatible 
with Avery form 8371.  

Access the L-BOSS reports menu and open the Clients folder.  

  

Use the "Preview" button if you want to view the report 
on screen before printing. Like any "print preview" 
option, you will still be able to send the report to the 
printer after viewing on screen. 
The "Print" button will send the report to the printer 
without viewing on screen first. Use the "Print" button if 
you are sure that the report contains the information you 
wish to view. 
The "Next" button is used to browse through open 
reports. 
"Cancel" to close the report selection utility and return 
to the L-BOSS desktop. 
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Whether you select Preview or Print, the Customer card report window will appear:  

   

Select a specific Group or leave blank for all 
customer groups. 

 

Select a specific customer or leave blank for all 
customers. 

 

Select a specific contact or leave blank for all 
contacts.

 

L-BOSS allows you to define the starting 
position for the first card to print. This 
means that partially used paper stock can 
be recuperated. Click on the label where 
you want the printing to start. 
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Notes:  


